
NOVEMBER 4, 2003 MEETING

The Power of AppleScript  
with Ben Waldie
On November 4 at 7:30 p.m. in 
Hogdon IRCʼs Lecture Hall 4 on 
the SUNY Oneonta campus, na-
tionally-renowned AppleScript 
expert Ben Waldie presented the 
November MUG ONE program. 

Ben is the president and founder of Automated Workflows, 
LLC, a Pennsylvania-based firm specializing in AppleScript 
and workflow automation consulting and development. 
Ben showed meeting attendees how to use AppleScript, 
Apple s̓ free, built-in scripting language, to automate repeti-
tive tasks on their Macs. Ben kindly provided a link to a set 
of sample AppleScripts for MUG ONE members to try.
http://homepage.mac.com/applescriptguru/Downloads/
UG_AS_PKG.sit
Clicking on the link from the PDF version of this newsletter 
should automatically start the download. Many thanks to 
Ben for driving all the way from Philadelpia to introduce 
us to Applescript.
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MAC OS X V10.3 PANTHER ARRIVES
The second major upgrade to Mac OS X arrived on October 
24. Heralded by rollout parties and sporting 150 new features, 
OS X v10.3 “Panther” comes a little more than a year after OS 
10.2 “Jaguar” brought major enhancements to to OS X. 
Panther highlights include a redesigned Finder, fast switching 
between users, FileVaultʼs advanced file security, and Exposé 
for one keystroke access to any open window. Panther costs 
$129, or $199 for a five-license family pack. Students and 
educators can purchase Panther for $69. Panther requires a 
PowerPC G3, G4, or G5 processor; built-in USB; and 128MB 
of physical RAM. Apple has posted a Panther support page 
with upgrading help, tips and discussion boards. 
Our advice? Back up your data, follow installations carefully, 
and purchase the Take Control PDF eBooks for the latest info 
and tips.
http://www.info.apple.com/usen/panther/
http://www.tidbits.com/takecontrol/default.html
Important Note: Apple warns users with FireWire 800 disk 
drives to install firmware updates before installing Panther.
http://www.apple.com/macosx/firewire800specialmessage.html 

DECEMBER PRESENTERS NEEDED!
MUG ONEʼs annual holiday meeting and party is coming 
on December 2, and youʼre invited to play a part.
Do you have a favorite Mac program that you would be 
willing to demonstrate? How about a cool peripheral or 
accessory? Weʼre looking for several brief demos - between 
five and ten minutes each. Game demos are welcome (not 
too gory, please!), as are demos of handy utilities, iPod 
accessories, cameras and camera accessories, keyboards, 
mice, storage devices, handhelds, and heck, anything else 
you think your fellow MUG ONE members might find 
interesting. 
Ready to volunteer? (Sure you are!) Please contact Program 
Chair John Maas at 437-0665, or drop him an email at 
xaxat@stny.rr.com. Let him know if you will require any 
special equipment, or if you need to install an application 
on a presentation machine ahead of time. 
Itʼs also not too early to start thinking about what holiday 
goodies youʼll want to bring for the party after the meeting. 
Be sure to join us, and start the season right!

http://homepage.mac.com/applescriptguru/Downloads/UG_AS_PKG.sit
http://homepage.mac.com/applescriptguru/Downloads/UG_AS_PKG.sit
http://www.mugone.com
http://www.apple.com/macosx/firewire800specialmessage.html 
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ADAM ENGST & TIDBITS UNVEIL TAKE 
CONTROL PDF BOOKS ON 10.3 PANTHER 
Want to take control of upgrading to OS 10.3 Panther? Check out 
the innovative and affordable new Take Control electronic book 
series from Adam and Tonya Engst ofTidBITs. Take Control 
ebooks are professionally produced mini-books by Mac experts 
on timely Mac topics. The titles are published directly to PDF 
format, which speeds them to your Mac without the delays 
of print publishing. Because theyʼre published electronically, 
titles can swiftly updated. The Take Control series leverages 
the capabilities of the Internet in ways that could well change 
the face of tech publishing. 
The first two titles in the series are Take Control of Upgrad-
ing to Panther by Joe Kissell (65 pages) and Take Control of 
Customizing Panther by Matt Neuberg (29 pages). Kissellʼs 
book gives invaluable step-by-step instructions for upgrading 
to Panther as well as troubleshooting help and tips for avoiding 
trouble in the first place. Neubergʼs book offers undocumented 
Panther details and helps you create shortcuts and customize 
your installation, Finder windows, Exposé, Font menus and 
more. Each is well worth the modest $5 cost.
Take Control titles are purchased through the TidBITs website 
via Kagi online ordering service. Both books I purchased were 
ready for downloading within a few minutes of placing my 
order. Books arrive in the form of trim PDF files that can be 
read on your Mac using the free Acrobat Reader software—no 
specialized software required. The books print out nicely if you 
prefer a hard copy. However, reading on an internet-connected 
Mac allows you to take full advantage the books  ̓internal and 
web hyperlinks:  selections of internet-style clickable text that 
jump you to related topics within the book and on the internet. 
Bill Atkinson, the creator of HyperCard, would be proud.
Just two weeks after Take Control of Upgrading to Panther 
was published, Take Control issued an updated version of the 
book (delivered free to current owners) covering late-breaking 
developments. Thatʼs impressive customer service under any 
circumstance, and for a $5 investment, itʼs simply amazing. 
http://www.tidbits.com/takecontrol/

 – ELSA TRAVISANO

IPOD NOW RECORDS, STORE PHOTOS 
The iPod has been a breakaway hit for Apple, appealing to 
music and audio book lovers on both the Mac and Windows 
platforms. Now add-ons from Belkin allow third generation, 
dockable iPods to be used as voice recorders, and even to store 
photos from your digital camera. These capabilities promise 
to broaden the appeal of the iPod even further. Holiday gift 
givers, take note!
Students, reporters and others with the need make voice-quality 
recordings at close range (up to 2 feet is optimal) will appreciate 
Belkinʼs $49 Voice Recorder. The recorder includes an omnidi-
rectional microphone and a speaker, and it clips on to the iPod 
through the headphone connectors on top. It can can record 
up to 600 hours of spoken word-quality audio, depending on 
the capacity of your iPod. You can review recordings through 
the speaker or through youri Podʼs headphones. The Voice 
Recorder-equipped iPod can even work as an alarm clock.
The Belkin iPod Media Reader ($99) fills a huge need for 
vacationers and professional photographers. If you have ever 
taken a trip with your digital camera but without your computer, 
youʼve probably spent way too much time squinting at that 
tiny display and deleting shots to make more room on your 
digital media cards. 
With the Media Reader, those headaches are gone. The reader 
allows you to fill up your cameraʼs media card with photos, 
transfer the photos to your iPod, then erase the card and keep 
on taking pictures. When you get back to your Mac you can 
download your photos into iPhoto or access them manually. 
The reader is slightly bigger than the iPod and plugs into the 
dock connector. It handles the five most common formats of 
media cards, and can store up to 20,000 digital photos from a 
3 megapixel camera on an otherwise-empty 40GB iPod. 
The Belkin Voice Recorder and the Belkin Media Reader were 
announced on October 16, and should be shipping soon. Both 
require a software update to iPod version 2.1, and both are 
compatible only with the third generation, docking iPods.
http://www.apple.com/ipod/accessories.html
http://www.apple.com/ipod/download/

– ELSA TRAVISANO

The Belkin Voice Recorder, $49, and Media Reader, $99

http://www.tidbits.com/takecontrol/
http://www.apple.com/ipod/accessories.html
http://www.apple.com/ipod/download/
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SPECIAL OFFERS - APPLE USER GROUP 
BULLETIN 
These user group discounts are brought to you by the Apple 
User Group Advisory Board. You must be a current MUG 
member to qualify for these savings. Not a member? Join a 
user group today to qualify for these savings.

Digi-Elements
Bring Sunny Skies to Photoshop
Have you ever wished you could add a cloud to a picture? Add 
water with reflections? Wouldnʼt it be great if you could do all 
that in Photoshop without learning 3D modeling?
Aurora 2 is a Photoshop plug-in that adds 3D clouds, skies, 
sun, moon, stars, water, and more in Photoshop. Aurora makes 
creating 3D nature easy and offers a lot of power.
Normally $179 for the download version, MUG members can 
get Aurora for only $135  -- thatʼs 30 % off. Use the electronic 
coupon code MUG2003. 
http://www.digi-element.com
Offer expires March 31, 2004.

Live Oak Hosting
Live Oak Hosting offers personal, reliable service for all of 
your hosting needs.  If you are tired of being “just another 
customer” or getting the run-around by your current web host, 
give Live Oak Hosting a try.
- Webmail
- MySQL Database
- IMAP & POP Email
- PHP & ASP
- Web-based Domain Manager
Prices starting at $45 per year!
We are extending an additional 10 percent discount on all of 
our annual plans until 12/31/04.
Visit Live Oak Hosting today and let us help you grow your 
business.
http://liveoakhosting.com/mac.php
Offer expires December 31, 2004.

Nova Development
The ultimate Macintosh greeting card software allows you to 
make beautiful store-quality greeting cards for every occasion in 
minutes! With millions of unique possibilities, 3,000+ greeting 
cards, 45,000+ sensational graphics, and over 500 color photo-
graphs to choose from, Greeting Card Factory for Macintosh 
is the easiest and most complete software of its kind.
Regularly $49.95, this product has a limited-time introduc-
tory special offer price of $34.95 (US), a 30 percent discount 
EXCLUSIVELY for Macintosh User Group members. Limit 
one per household.
To order, go to http://www.novadevelopment.com/dm1447mft/ 

and enter Priority Code 1447.
Offer expires January 31, 2004.

The Omni Group
The Omni Group develops beautifully designed, powerful 
productivity applications. OmniWeb is a feature-rich web 
browser designed to put you in control, OmniGraffle is an 
intuitive diagramming and drawing tool, and OmniOutliner 
is an indispensable program for outlining and organizing 
information. Get all of these Mac OS X apps and more at a 
great price!
User group members are now eligible for a 40 percent discount 
on ALL of Omniʼs products.
Visit https://store.omnigroup.com and enter the code MUG to 
apply the discount towards any purchase.
Offer expires January 31, 2004.

The MUG Store
The MUG Store has a huge assortment of great deals right 
now. Check them all out. Examples include:
- Factory refurbished and new iPods starting at only $199 
- iMacs from $599
- eMacs from $699 
- iBooks from $788 
- Brand new LCD iMacs from $999
- Brand new G4 PowerBooks from $1,349 
- A great selection of blowout accessories and closeouts
Remember, UPS freight is free on all orders, and your group gets 
one percent in credit for every order your members place.
http://www.applemugstore.com
Login (Oct. 1 - Dec. 31)
User ID: G5 / Password: processor

 ITUNES & ITUNES MUSIC STORE
iTunes, Appleʼs digital jukebox software, has added features 
and expanded its reach to the world of Windows.The newly 
released iTunes for Windows lets Windows users manage their 
music, use their iPods and access the online iTunes Music Store 
with an interface virtually identical to the Mac version. 
The iTunes Music Store adds several new features. including:
• Gift Certificates that can be purchased through iTunes Music 
Store or the Apple Store
• Allowance accounts, so kids can access music legally and 
without a credit card 
• More than 5,000 Audible audiobooks
• 400,000 tracks available for purchase at 99¢ each, up from 
200,000 
iTunes Music Storeʼs enhancements require iTunes 4.1 (works 
with Mac OS X 10.1.5 and higher, Windows 2000 and XP).
http://www.apple.com/itunes/

http://www.digi-element.com 
http://www.digi-element.com 
http://liveoakhosting.com/mac.php
http://www.novadevelopment.com/dm1447mft/ 
https://store.omnigroup.com
http://www.applemugstore.com
http://www.apple.com/itunes/
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MAC 911
DEFINING MOMENT
By Christopher Breen
Catalog the component parts of the human 
body, and youʼll find items whose occupa-
tion is unclear—the spleen, baby toe, and 
uvula come to mind. So, too, does Mac OS 

X contain elements with functions that arenʼt easily defined. 
With that in mind, letʼs explore some underilluminated aspects 
of OS X, such as services, invisible database files, and shuffled 
iMovie export options. To round things out, I correct lopsided 
sound, push the envelopes, and counsel a family in need. 

Terms of Services 
How do I get the items in the Services menu to work? For 
example, I want to grab a screen shot, but in every application 
Iʼve tried, the Grab command s̓ options are grayed out. 
 − Sean T. OʼBrien, Charlottesville, Virginia 
For those readers whoʼve just pulled up the Finder menuʼs 
Services command and remarked, “Hey, those services look 
pretty darned active to me!” I suggest opening an application 
such as AppleWorks or Microsoft Word and giving it another 
whirl. Youʼll discover that services are serviceable only in 
applications written in OS Xʼs Cocoa environment, such as 
TextEdit and Safari. Carbon applications (such as AppleWorks, 
Word, and Adobe Photoshop) and OS 9 applications, including 
QuarkXPress and Coda Finale, canʼt take advantage of services.  
The Grab service is even more limited. Services canʼt create 
documents, so the Grab service canʼt act like the similarly named 
Grab application (or even the 1-shift-3 keyboard shortcut). The 
service canʼt take a screen shot and save it as a separate docu-
ment. Instead, the Grab service can only add a capture to an 
open document in a supported Cocoa application. For example, 
if you have an RTF (Rich Text Format) TextEdit document 
open and active, the Grab service can capture the screen and 
place the resulting capture into the RTF document. 

Desktop Database Files 
What is in the Desktop DB file that appears when you create a 
disc image with OS X s̓ Disk Copy? Is it possible to remove that 
file permanently before burning a CD-ROM or DVD-ROM? 
− Derek Coller, Seattle, Washington 
The Desktop DB file is an invisible database file found at the root 
level of every volume on your Mac. This file contains informa-
tion about the applications and documents within that volume; 
itʼs also the repository for the comments in the Finderʼs Get 
Info windows. When you burn a CD, this file—and its sibling, 
Desktop DF—appear on the disc and cannot be removed. 

Although you canʼt delete the file, you may have some control 
over what it contains. By default, when you burn a disc in either 
the Data or MP3 formats with Roxioʼs $100 Toast 5 Titanium 
(866/279-7694, www.roxio.com), Toast grabs the Desktop DB 
file that it deems most appropriate from your Mac and places it 

on the disc. Were you to view that Desktop DB file with a text 
editor, youʼd discover that it contained—along with strings of 
nonsensical characters—the names of the applications you use, 
as well as any URLs stored in the Finderʼs comments field. As 
you can imagine, some people would prefer not to spread this 
information around.  If this concerns you, you can instruct Toast 
to create an empty database file. Just double-click on the CD 
icon in Toastʼs Data window and select the Use Empty Desktop 
Database option. Even if youʼre unconcerned about security, 
youʼll discover that invoking this option saves space. I found 
that leaving this option off resulted in a 612K Desktop DB file 
on a test disc. With the option on, Desk-top DB was a slim 4K. 
Appleʼs Disc Burner automatically creates an empty database 
file, so you neednʼt worry that a Desktop DB file will give away 
your applications  ̓names or your browsing habits. 

Toast Pointer 
I have iMovie 3 and would like to use it with Roxio s̓ Toast to 
create Video CDs of my movies. When I updated from iMovie 
2 to iMovie 3, I no longer saw an option for exporting to Toast. 
How can I get it back?  − Bret Waters, Oak Hill, Vermont 

As you suggest, in iMovie 2 you prepared your movies for 
Toast by selecting the Export command from iMovieʼs File 
menu, choosing To QuickTime from the Export pop-up menu 
that appeared in the resulting Export Movie window, and then 
selecting Toast Video CD from the Formats pop-up menu. 
Apple, for better or worse, has changed the way the Export 
command works in iMovie 3. 

In the latest iteration of iMovie, selecting the Export com-
mand produces the iMovie: Export window. To access the 
Toast Video CD option, you must select To QuickTime from 
this windowʼs Export pop-up menu and then Expert Settings 
from the Formats pop-up menu. Click on the Export button 
in this window to produce the Save Exported File As dialog 
box, where you choose Movie To Toast Video CD from the 
Export pop-up menu. Click on the Option button in the same 
window to choose the format for your movie (NTSC or PAL). 
Finally, click on Save in the Save Exported File As dialog 
box, and youʼve saved your movie as an MPEG-1 file ready 
for Toasting. 

Unbalanced Sound 
While shooting a movie, I used a mono microphone with my 
camcorder. As I edited my footage in iMovie 3, I discovered that 
the sound came only from the left speaker. How do I change 
the audio track so it comes from both speakers? 
− Robert Rouveroy, The Hague, Netherlands 
How you approach this problem depends on how much of the 
movie exhibits this monomaniacal behavior. If the iMovieʼs 
entire soundtrack is broadcast from only one speaker, you can 
easily fix the problem when you export the movie. Just select 
Export from iMovieʼs File menu, select To QuickTime from 

continued on page 5

http://www.roxio.com
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the Export pop-up menu and Expert Settings from the Formats 
pop-up menu, and click on the Export button. In the resulting 
Save Exported File As window, select Movie To QuickTime 
in the Export pop-up menu and click on the Options button. In 
the Movie Settings window that appears, click on the Settings 
button in the Sound portion of the window. In the resulting 
Sound Settings window, enable the Mono option and click on 
OK in both the Sound Settings and Movie Settings windows.  
Click on Save in the Save Exported File As window. Your 
movie will be saved with a mono soundtrack that places all 
sounds in the middle of the stereo field. 

If this problem occurs only with some individual clips—the rest 
of your movie is in stereo except for selected interviews, for 
example—the best way to tackle the problem is to quit iMovie, 
edit those individual clips in QuickTime Pro, and then import 
them into iMovie again.  To do so, open the project folder for 
your iMovie. Inside youʼll find files labeled Clip 1, Clip 2, 
and so on. These clips correspond to the video clips youʼve 
imported with iMovie. Open the clips that have the wonky 
audio in QuickTime Player Pro. Select Extract Tracks from the 
Edit menu, choose Sound Track in the Extract Tracks window, 
and click on the Extract button. This produces a new untitled 
QuickTime movie containing the clipʼs soundtrack. Letʼs call 
that file Mono Audio.  With this file active, select Export from 
the File menu and choose Sound To AIFF from the Export pop-
up menu in the Save Exported File As window.  Click on the 
Options button, and in the resulting Sound Settings window, 
enable the Mono option. Click on OK to dismiss this window, 
and click on Save in the Save Exported File As window to 
save your sound. Youʼve just created a mono audio file with 
the sound in the middle of the stereo field.  Now return to the 
clip file from which you extracted the sound and select Delete 
Tracks from the Edit menu. In the Delete Tracks window, select 
Sound Track and click on the Delete button. This deletes the 
faulty audio file. To replace it with the mono file you created, 
activate the Mono Audio file by clicking on it, press 1-A to 
select all of its contents, and press 1-C to copy them. Click on 
the clip file, select Add Scaled from the Edit menu, and save 
the file. This adds the contents of the Mono Audio file to the 
video clip file and produces a clip whose soundtrack comes out 
of both speakers. Repeat this procedure for each wonky clip.  
When youʼre finished, import the repaired clips into iMovie 
and vow to never use a mono microphone again. 

Belly Up to the Bar Code 
Iʼm looking for software that can print labels and envelopes with 
a bar code. In the past I used MacEnvelope, but the program 
hasn t̓ been updated for OS X. Do you have any  suggestions? 
− Mark M. Arias 

I can recommend two applications. The first is Scruffy Soft-
wareʼs $15 Address Book Reports (www .scruffyware.com/
products/digilifereports/ Address BookReports.html). This 
utility can generate envelopes and labels with bar codes from 

contacts stored in OS Xʼs Address Book. In addition, it can 
neatly organize and print your Address Book contacts into 
reports styled like phone books and business cards. 

Ampersandboxʼs $20 Imprint (www.ampersandbox.com) is 
another option that integrates with OS Xʼs Address Book. It 
supports a wider variety of label and envelope types. 

Monitoring the Family 
Members of my family refuse to use their own user accounts 
on our Mac running OS X 10.2.6. Since our Mac automatically 
logs in with my account, they change my settings and proceed 
with their work. Fortunately, they typically limit their fiddling 
to the sound level, monitor resolution, and Dock size. 

I can quickly change the sound and Dock back to my preferred 
settings, but adjusting the monitor resolution is a nuisance 
because the resolution and refresh rate that I want are not 
listed in the Displays pull-down menu. Is there an easier way 
than opening the Displays system preference to access monitor 
settings?  − Tim Collins, Marshfield, Wisconsin 
Tim, Iʼd like to take the liberty of providing the solution you 
seek while also butting into your familyʼs business. Letʼs start 
with the solution. 

Venture to www.madrau.com and download a copy of Stéphane 
Madrauʼs $15 SwitchRes X. SwitchRes places a small icon in 
the Mac s̓ menu bar that includes all the resolutions your monitor 
is capable of displaying. If youʼre the tinkering type, you can 
also ask SwitchRes to display unsupported resolutions. You 
should be careful with the latter feature, as you could create a 
setting that your monitor canʼt display, which can cause some 
monitors to display a dark screen until you reset the Macʼs 
parameter RAM (by holding down 1-option-P-R at startup).  
At the risk of causing discord around the dining-room table, 
I suggest that you avoid this problem altogether by config-
uring the Mac to require each user to log in with his or her 
own password. That way Momʼs, Dadʼs, and Sister Berniceʼs 
computing environments will be configured exactly the way 
they like from the minute they log on—no need to mess about 
with another family memberʼs settings. 

To do so, open the Accounts system preference with an account 
that has Administrator privileges. 

In the Users section of the Accounts window, deselect the Log 
In Automatically As option. Now select the Login Options tab 
and enable the List Of Users option. When you log out, each 
member of the family will be required to enter his or her own 
password to log in to the Mac. 

Tip of the Month 
Many AirPort users have found that their wireless connection 
fails when they use a 2.4GHz wireless phone near their networks. 
This failure happens because the phone and AirPort share the 

 – Mac 911, continued from page 4

continued on page 6
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same frequency. Worse yet, these phones prefer channel 6 of 
the 11 channels available to these devices, and some AirPort 
networks are set to channel 6 by default.  Fortunately, thereʼs 
a workaround. 

Launch the AirPort Admin Utility, click on the Configure but-
ton in the Select Base Station window, select the AirPort tab 
in the resulting window, and choose a number such as 1 or 11 
from the Channel pop-up menu.  Click on the Update button 
to update your Base Station, and your interference problems 
should cease.  − Andrew Shalat, Palos Verdes, California 

Unsolicited Advice 
Because I lack the organization gene, over the course of a 
computing year I often give multiple files the same name—Mac 
911, for example—and fling these files into every conceivable 
corner of my Macʼs hard drive.  If youʼre similarly impaired, 
you may depend as much as I do on OS Xʼs ability to find 
files by content. 

But properly doing this requires more than pressing 1-F in the 
Finder, selecting Content from the Add Criteria pop-up menu in 
the resulting Find window, and entering a couple of words in the 
Content Includes field.  Youʼll have far better luck unearthing 
the files you desire if you index any volumes or folders you 
intend to search.  To do so, select a folder (your user folder is 
a good place to start) or volume, and press 1-I to produce the 
Get Info window. In that window, click on the triangle next 
to the Content Index entry. Then click on the Index button. In 
a few (quite a few, depending on how many files you have) 
minutes, your Mac will index the contents of all text, HTML, 
PDF, and clippings files. 

To speed the indexing process (and keep the hidden index files 
this process produces as slim as possible), select Preferences 
from the Finder menu and click on the Select button that ap-

pears below the Languages For Searching File Contents entry 
at the bottom of the Finder Preferences window. In the resulting 
Languages window, deselect those languages you donʼt want 
to use when searching the contents of your files—Slovene and 
Afrikaans, for instance—and click on OK. 

Macworld contributing editor Chris Breen is the author of Macworld s̓ 
tips and troubleshooting column, “Mac 911,” as well as Secrets of 
the iPod: Second Edition and Mac 911 (Peachpit Press). Find Chris  ̓
books at http://www.amazon.com and http://www.peachpit.com. User 
Group Special: Get 12 issues of Macworld for $12! Subscribe today 
at http://www.macworld.com/dollarperissue.
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ADOBE CREATIVE SUITE NOW SHIPPING
If youʼve been waiting for an upgrade to Photoshop, Illustra-
tor, GoLive or InDesign, Adobe has a heap of good news for 
you. For the first time, Adobe has upgraded all its core creative 
applications in one fell swoop, collected them under the name 
Adobe Creative Suite, and connected them to one another with 
a “control center” application. Illustrator, Photoshop, GoLive 
and InDesign have all shed their version numbers and are now 
designated CS, for Creative Suite. Each application is available 
separately, but theyʼre designed to function optimally as an 
ensemble, orchestrated by the new Version Cue utility which 
is available only as part of the Creative Suite.
Creative Suite is available in two versions:  Standard, which 
includes Photoshop CS, Illustrator CS, InDesign CS and Ver-
sion Cue; and Premium, which adds GoLive CS and Acrobat 
6.0 Professional. You can upgrade an individual application at 
reduced price if you own an earlier full version of that applica-
tion. In addition, if you own an earlier version of Photoshop, 
you are eligible to purchase either version of the Creative Suite 
at the upgrade price. Academic pricing is available at significant 
reductions. For full information, go to Adobeʼs website. 
http://www.adobe.com

http://www.amazon.com
http://www.peachpit.com
http://www.macworld.com/dollarperissue
http://www.adobe.com

